BABI1

LANDASAN TEORI
2.1 Siklus Akuntansi

American Accounting Association (AAA) mendafenisikan akuntansi
sebagai proses pengidentifikasian, pengukur dan pelaporan informasi ekonomi
untuk memungkinkan adanya penilaian — penilaian keputusan yang jelas dan
tegas bagi mereka yang menggunakan informasi tersebut.

Menurut Dwi Martani, dkk (2017:63) siklus akuntansi merupakan
keseluruhan proses yang dilakukan oleh entitas untuk mengolah data — data
keuangan hingga menjadi informasi yang bermanfaat bagi pengguna untuk
pengambilan keputusan.

Gambar 2. 1

Siklus Akuntasi
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Sumber : Dwi Martani, dkk (2017:63)
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1. Identifikasi peristiwa dan pencatatan transaksi
Identifikasi transaksi merupakan proses merupakan proses penentuan
apakah peristiwa ekonomi yang relevan dan memiliki dampak finansial
pada perusahaan, sementara pencatatan transaksi adalah proses mencatat
kejadian tersebut dalam jurnal akuntansi.
2. Jurnal
a. Jurnal Umum adalah alat untuk mencatat transaksi perusahaan yang
dilakukan berdasarkan urutan waktu terjadinya dengan menggunakan
aturan debit dan kredit sebuah transaksi awalnya dimasukkan ke dalam
ke dalam catatan.

b. Jurnal Khusus dibagi menjadi empat yaitu :

1. Jurnal penjualan, digunakan untuk mencatat transaksi barang
dagang ke pelanggan secara kredit.

2. Jurnal penerimaan kas, dugunakan untuk mencatat aktivitas
penerimaan kas dari berbagai sumber penerimaan kas dalam
perusahaan.

3. Jurnal pembelian, untuk mencatat transaksi pembelian barang
dagang, dari supplier secara kredit.

4. Jurnal pengeluaran kas, digunakan untuk pencatatan aktivitas
pengeluaran kas dari berbagai sumber pengeluaran kas dalam

perusahaan.
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3. Posting
Pemindahbukuan (posting) merupakan langkah untuk melakukan
klasifikasi akun — akun yang sesuai dalam buku besar (ledger). Langkah —
langkah melakukan posting adalah sebagai berikut.
a. Mengidentifikasikan nama akun yang terkait dan memindahkan
jumlah pada kolom debit/ kredit pada akun di buku besar.
b. Menuliskan kode nomor akun pada kolom referensi akun di buku
besar.
c. Setelah proses pemindahbukuan selesai, saldo akhir masing —
masing akun dalam buku besar ditentukan dan nantinya

dipindahkan ke buku besar

4. Neraca saldo

Neraca saldo (trial balance) berisi saldo akhir kumpulan akun pada
akhir periode. Penyusunan neraca saldo disusun berdasarkan saldo normal
akun debit dan kredit, dimulai dari akun aset, liabilitas, ekuitas, pendapatan,
dan beban. Neracar saldo tidak dimaksudkan untuk memastikan bahwa
seluruh transaksi dan posting ke buku besar telah dilakukan dengan benar.
Sebaliknya, sesuai dengan namanya (trial balance), saldo debit dan neraca
saldo harus seimbang (balance). Neraca saldo bermanfaat untuk mendeteksi

kesalahan dalam proses jurnal dan posting.
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5. Jurnal Penyesuaian
Ayat jurnal peneysuaian dilakukan terhadap dua kategori akun yaitu
pembayaran di muka (prepayments) dan akrual (accruals). Hal yang
termasuk dalam kategori pembayaran dimuka adalah sebagai berikut.

1. Beban dibayarkan dimuka (prepaid expenses), yaitu seluruh beban yang
telah dibayar secara tunai, namun masih belum dimanfaatkan atau
digunakan, dan dicatat scbagai aset.

2. Pendapatan diterima dimuka (unearned refenues), yaitu seluruh
pendapatan yang telah diterima secara tunai, namun jasa atau barang
masih belum diserahkan, dan dicatat sebagai liabilitas.

Sedangkan akrual meliputi sebagai berikut.

1. Pendapatan yang diterima (accrued revenues), yaitu seluruh pendapatan
yang telah diselesaikan penyerahan jasa atau brang terkait, namun
belum diterima pembayaran tunainya atau belum dicatat.

2. Beban yang belum dibayar atau eban yang harus dibayar (accurued
expeses), yaitu seluruh beban yang sudah terjadi ( dimanfaatkan atau
digunkan), namun belum dibayarkan secara tunai.

6. Neraca Saldo Disesuaikan
Setelah ayat jurnal penyesuaian telah dibuat dan dipindahkan, neraca
saldo yang disesuaikan disiapkan untuk memeriksa kesamaan jumlah saldo
debit dan kredit. Hal ini adalah langkah terakhir sebelum menyiapkan
laporan kevangan, dan semua kesalahan yang muncul dari proses

pemindahan ayat jurnal penyesuaian harus ditemukan dan diperbaiki.
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7. Laporan Keuangan
Hasil terpenting dari siklus akuntansi adalah laporan keuangan.
Laporan laba rugi disiapkan terlebih dahulu, diikuti laporan ekuitas pemilik,
kemuadian laporan posisi keuangan. Laporan keuangan dapat disiapkan
langusung dari neraca saldo yang disesuaikan, kertas kerja akhir periode,
atau buku besar. Laba neto atau rugi neto yang ditunjukkan dalam laporan
laba rugi disajikan dalam laporan ckuitas pemilik bersama dengan
penambahan investasi dan juga penarikan oleh pemilik. Saldo akhir modal
pemilik dilaporkan di Laporan posisi keuangan dan ditambahkan dengan
liabilitas untuk menyamakan jumlah aset.
8. Jurnal Penutup
Empat ayat jurnal penutup dibuat pada akhir periode akuntansi agar
akun — akun siap digunakan kembali pada periode berikutnya. Empat ayat
jurnal tersebut adalah :Semua pendapatan didebit sebesar saldonya dan
mengkredit ikhtisar laba rugi.
1. Semua beban dikredit sebesar saldonya dan mendebit ikhtisar laba rugi.
2. Ikhtisar laba rugi didebit sebesar saldonya dan mengkredit modal
pemilik.
3. Prive pemilik dikredit dan mendebit modal pemilik.
9. Neraca Saldo Setelah Penutupan
Neraca saldo setelah penutupan memastikan bahwa buku besar telah
sesuai pada awal periode berikutnya. Semua akun beserta saldo dalam
neraca saldo setelah penutupan harus sama dengan akun dan saldo dilaporan

posisi keuangan diakhir periode.

Dipindai dengan CamScanner


https://v3.camscanner.com/user/download

14

10. Jurnal Pembalik
Jurnal pembalik adalah jurnal yang dibuat pada awal periode dengan
cara membalik jurnal penyesuaian yang sudah dilakukan diakhir periode
sebelumnya dengan tujuan untuk memudahkan pencatatan transaksi pada
periode berikutnya. Akun sebelumnya didebit dibalik ke akun kredit dan

akun yang sebelumnya dikredit dibalik kea kun debit.

2.2 Standar Akuntansi Keuangan yang berlaku di Indonesia
Menurut Ikatan Akuntansi Indonesia (IAI) di Indonesia terdapat lima jenis
standar akuntansi keuangan yang berlaku yaitu :
1. Standar Akuntansi Keuangan (SAK)

Standar Akuntansi Keuangan (SAK) adalah pernyataan Standar
Akuntansi Keuangan (PSAK) dan Interpretasi Standar Akuntansi Keuangan
(ISAK) yang diterbitkan oleh Dewan Standar lkatan Akuntan Indonesia
(DSAK IAI) dan Dewan Standar Syariah Ikatan Akuntan Indonesia (DSAS
IAI) serta peraturan regulator pasar modal untuk entitas yang berada
dibawah pengawasannya.

2. Standar Akuntansi Keuangan Entitas Privat (SAK EP)

Standar Akuntansi Keuangan (SAK) Entitas Privat disusun untuk
memenuhi kebutuhan pelaporan keuangan entitas privat. SAK Entitas Privat
ditujukan untuk digunakan oleh entitas yang tidak memiliki akuntabilitas
public dan menerbitkan laporan keuangan untuk tujuan umum (general

purpose financial statements) bagi pengguna ekternal.
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3. Standar Akuntansi Keuangan untuk Entitas Tanpa Akuntabilitas
Publik (SAK ETAP)

Standar Akuntansi Keuangan untuk Entitas Tanpa Akuntabilitas
Publik (SAK ETAP) dimaksudkan untuk digunakan oleh Entitas Tanpa
Akuntabilitas Publik signifikan dan menerbitkan laporan keuangan untuk
tujuan umum (general purpose financial statement) bagi pengguna
cksternal. SAK ETAP bertujuan untuk menciptakan fleksibilitas dalam
penerapannya dan diharapkan memberi kemudahan akses ETAP kepada
pendanaan dari perbankan.

4. Standar Akuntansi Keuangan Entitas Mikro Kecil Menengah (SAK
EMKM)

SAK EMKM merupakan Standar Akuntansi Keuangan yang berdiri
sendiri yang dapat digunakan oleh entitas yang memenuhi defenisi entitas
tanpa akuntabilitas public yang signifikan sebagaimana yang diatur dalam
SAK ETAP dan karakteristik dalam undang — undang No 20 Tahun 2008
tentang usaha Mikro Kecil dan Menengah (UMKM).

5. Standar Akuntansi Syariah (SAS)

Standar Akuntansi Keuangan Syariah (SAS) berbasis pada konsep —
konsep akuntansi umum yang telah disesuaikan dengan prinsip — prinsip
syariah. Konsep i tercermin dalam kerangka dasar pesnyusunan dan

penyajian laporan keuangan syariah.
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2.3 Pelaporan Keuangan Berdasarkan Standar Akuntansi Keuangan Entitas

Mikro Kecil dan Menengah (SAK EMKM)

Menurut Ikatan Akuntansi Indonesia (IAI) Laporan keuangan minimum

terdiri dari :

a. Laporan keuangan pada akhir periode

b. Laporan laba rugi selama periode

c. Catatan atas laporan keuangan, yang berisi tambahan dan rincian akun
— akun tertentu yang relevan.

A. Laporan Posisi Keuangan

Laporan posisi keuangan entitas dapat mencakup akun — akun berikut :
a) Kas dan setara kas
b) Piutang
¢) Persediaan
d) Aset tetap
¢) Utang usaha
f) Utang bank

g) Ekuitas

SAK EMKM tidak menentukan format atau urutan terhadap akun —
akun yang disajikan. Meskipun demikian, entitas dapat menyajikan akun —
akun aset berdasarkan urutan likuiditas dan akun — akun liabilitas

berdasarkan urutan jatuh tempo.

B. Laporan Laba Rugi

Laporan laba rugi entitas dapat mencakup akun — akun sebagai berikut :
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a) Pendapatan
b) Beban keuangan

¢) Beban pajak

Laporan laba rugi memasukkan semua penghasilan dan beban yang
diakui dalam suatu periode, kecuali SAK EMKM mensyaratkan lain.
SAK EMKM mengatur perlakuan atas dampak koreksi atas kesalahan
dan perubahan kebijakan akuntansi yang disajikan sebagai penyesuaian
retrospektif terhadap periode yang lalu dan bukan sebagai bagian dari

laba atau rugi dalam periode terjadinya perubahan.

C. Catatan Atas Laporan Keuangan
Catatan atas laporan keuangan memuat :

a) Suatu pernyataan bahwa laporan keuangan telah disusun sesuai
dengan SAK EMKM

b) Ikhtisar kebijakan akuntansi

¢) Informasi tambahan dan rincian akun tertentu yang menjelaskan
transaksi penting dan material sehingga bermanfaat bagi pengguna
untuk memahami laporan keuangan.

Catatan atas laporan keuangan disajikan secara sistematis sepanjang hal

tersebut praktis. Setiap akun dalam laporan keuangan merujuk silang ke

informasi terkait dalam catatan atas laporan keuangan.
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2.4 Penyusunan Laporan Keuangan Menggunakan Excel For Accounting (EFA)
Excel For Accounting merupakan sebuah program aplikasi akuntansi yang
sering digunakan pada perusahaan kecil ataupun besar dalam penyusunan
laporan keuangan pada perusahaan dengan menggunakan aplikasi pada
Microsoft office yaitu Microsoft excel.
A. Kelebihan excel for accounting
1) Mudah dipahami
2) Ada kemudahan dalam laporan keuangan
3) Memiliki standar pelaporan sesuai standar akuntansi
B. Kekurangan excel for accounting
1) Tidak bisa mengkonversikan data excel for accounting ke aplikasi
akuntansi lainnya seperti MY OB, Accurate, dan lainnya.
2) Mudah terjadi kesalahan apabila tidak memahami pengaplikasian
rumus dalam Excel for Accounting
A. Fungsi yang digunakan pada Excel For Accounting
1. Fungsi SUM
Fungsi SUM adalah fungsi yang digunakan untuk menjumlahkan nilai
— nilai yang terdapat pada beberapa sel dalam suatu range tertentu
dengan rumus :
=SUM(Range).
2. Fungsi IF
Fungsi IF merupakan sebuah fungsi logika untuk menentukan suatu

keputusan berdasarkan suatu kondisi tertentu. Fungsi ini akan
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menghasilkan suatu nilai atau jawaban jika sesuai dengan kriteria yang
disyaratkan. Rumus fungsi IF adalah :
=IF(logical_test,value_if_true,value_if false)

Logical test adalah pengujian sebuah nilai dengan syarat tertentu.
Value if true adalah nilai atau jawaban pertama akan diberikan jika
syarat terpenuhi.

Value if false adalah nilai jawaban kedua akan diberikan jika syarat

tidak dipenuhi.

. Fungsi SUMIF

Fungsi SUMIF adalah fungsi yang digunakan untuk menjumlahkan nilai
yang terdapat pada beberapa sel dalam suatu range tertentu dengan
kriteria tertentu yang dihubungkan dengan range kriterianya. Rumusnya
adalah :

=SUMIF(Range,criteria,Sum_range)

Range adalah berisi data — data yang akan di evaluasi

Criteria adalah kriteria yang akan dijadikan dasar penjumlahan

Sum range adalah rangke yang berisi data yang dijumlahkan sesuai

dengan kriteria dan berhubungan dengan range pertama.

. Fungsi SUBTOTAL

Fungsi SUBTOTAL adalah fungsi yang menghasilkan nilai subtotal
dalam sebuah daftar atau database. Fungsi ini secara otomatis akan
terbentuk apabila bekerja dalam suvatu daftar atau database dengan

menggunakan menu Data>Subtotal. Fungsi ini dapat juga digunakan
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berkaitan berkaitan dengan tampilan data hasil dari suatu filter. Rumus
fungsi SUBTOTAL adalah :

=SUBTOTAL(Function_number,ref)

. Fungsi VLOOKUP

VLOOKUP adalah fungsi yang digunakan untuk membaca table dan
data secara vertikal sesuai dengan kriteria kolom paling awal dalam
suatu range table data. Rumus fungsi VLOOKUP sebagai berikut :
=VLOOKUP(lookup_value,table,array,col_index_num,range look
up)

Lookup adalah nilai yang dijadikan kriteria untuk membaca table data.
Table array adalah range table memuat data — data vang akan dibaca
dan lookup value terdapat pada range table tersebut pada kolom urutan
pertama.

Column nomor urut kolom yang memuat data yang akan dibaca dan
dihitung dari urutan paling awal table data (table array).

. Fungsi IF dan OR

Fungsi IF dapat menggunakan fungsi logika OR, fungsi OR dugunakan
untuk menentukan syarat diantara beberapa syarat, jika salah satu atau
semua syarat ada maka syarat terpenuhi. Rumus fungsi IF dan OR
sebagai berikut :

=IF(OR(long_test 1,long test 2,long_test n),value if true,value i
f valse)

Logical test adalah pengujian sebuah nilai melalui syarat tertentu.

Value if true adalah nilai atau jawaban pertama jika syarat terpenuhi.
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Value if true adalah nilai atau jawaban kedua jika syarat tidak
terpenuhi.

7. Rumus fungsi IF dan AND
Fungsi IF dapat menggunakan fungsi logika AND. Fungsi AND
digunakan untuk menentukan jawaban berdasarkan semua syarat. Jika
salah satu atau semua syarat ada maka jawaban terpenuhi. Rumus fungsi
IF dan AND sebagai berikut :
=IF(AND(long_test 1,long_test 2,long test n),value_if true,value
_if_valse)
Logical test adalah pengujian sebuah nilai melalui syarat tertentu.
Value if true adalah nilai atau jawaban pertama jika syarat terpenuhi.
Value if true adalah nilai atau jawaban kedua jika syarat tidak
terpenuhi.

B. Menu yang digunakan dalam Excel for aacounting (EFA)

1. Menu edit> copy dan menu edit> paste
Menu ini untuk membuat salinan (copy) dari sel ke sel lain.copyan
rumus dari satu sel ke sel lain dan nantinya rumus — rumus yang telah
dibuat akan diperbanyak. Untuk memperbanyak rumus tersebut tidak
perlu membuat ulang rumus tetapi cukup dengan menggunakan menu
edit>copy dan menu edit>paste atau dengan menggunakan keyboard
dan tombol CTRL + C untuk copy dan CTRL + V untuk paste.

2. Menu Insert>Name>Rename
Menu ini digunakan untuk mengganti nama sheet. Klik menu

Format>sheet>rename, atau dengan mengklik kanan dua kali pada
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sheet, dapat mengganti nama sheef sesuai dengan nama — nama lembar
kerja yang dibuat.

3. Menu Insert>Name>Define
Menu ini digunakan untuk memberi nama sel atau range. Untuk
memberi nama pada range tertentu yang sudah berisi data, pilih menu
Insert>Name>Defenisi kemudian letakkan kursor pada kotak dialog
Refer to, kemudian pindahkan dan letakkan kurasor pada sel range data
yang akan diblok dan blok range yang akan diberi nama sehingga kotak
dialog akan terisi sel atau range yang telah diblok. Untuk memberi nama
range, letakkan kursor pada dialog Name in Workbook dan ketik “Data”,
kemudian klik “4DD” untuk menambah range tersebut kedalam daftar
nama range, klik OK.

4. Menu Data>Filter>Auto Filter
Menu ini digunakan untuk membuat filfer (penyaring) data pada suatu
table.

C. Format langkah — langkah membuat laporan keuangan menggunakan

Microsoft excel

1. Format Daftar Akun
Daftar akun merupakan daftar semua akun yang akan digunakan dalam
buku besar yang berisikan kolom kode akun, nama akun, pos saldo, pos
laporan, dan saldo awal untuk mengetahui bagaimana saldo awal

perusahaan.
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Langkah — langkah dalam membuat daftar akun sebagai berikut :

1) Buatlah lembar kerja daftar akun pada sheet kedua seperti gambar

diatas.

2) Ganti nama sheet menjadi nama akun

3) Isikan lembar kerja tersebut dengan daftar akun saldo awal laporan

posisi keuangan seperti dibawah ini

"ER

Gambar 2. 2
Daftar Akun
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30 511 v Jis
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32 £100_|Beban Gaji Db
33 €200 |Beban Lutrk & Air ot
34 6300 _[Beban B3N [t
3 6400 _|Beban Pervmotan Pealan %
% 6300 |Beban tan andarian ot
37 §600_|Beban Penyomutan Samgunan. Db
3 £900_[Baban Lain Dt
53 §-300_|Beban Perienckanan iy L;
WA b ¥ Menu | doftarakun - DataPerlengkepan i bahen baky _ _Data PeralataniBanguren , Trastbs | Tr

Sumber : telah diolah oleh penulis

2. Format Kode Pembantu

Kode pembantu adalah data yang berisikan tentang kolom kode, nama

perusahaan, saldo awal untuk mengetahui bagaimana hutang piutang

yang ada di perusahaan.

Langkah — langkah dalam memuat daftar kode pembantu sebagai berikut

1) Membuat lemabar kerja kode pembantu pada sheet 4

2) Ganti nama sheet menjadi DAFTAR BUKU PEMBANTU

3) Isikan lembar kerja tersebut dengan daftar kode pembantu dan saldo

awal buku pembantu.
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4) Untuk kode, nama, dan saldo awal dilakukan dengan cara diketik.
5) Untuk status dilakukan dengan cara menggunakan data validation

yang berisikan hutang dan piutang.

. Format Jurnal Umum

Jurnal Umum adalah buku harian untuk mencatat transaksi keuangan

menurut urutan tanggal, dari tanggal awal hingga tanggal akhir ke dalam

kelompok akun debit dan kredit. Format jurnal umum berisi tentang

akun 1, akun 2, tanggal, bukti, keterangan, jurnal, kode akun, debit dan

kredit.

Langkah — langkah dalam membuat jurnal umum sebagai berikut :

1) Buatlah halaman kerja sheet ke empat

2) Ganti nama sheet empat menjadi jurnal umum

3) Buatlah drop-downlist box yang berisikan daftar — daftar kode akun
pada kolom akun yang telah dibuat pada halaman kerja daftar akun,
sehingga ketika akan mengisi kode akun cukup dengan cara klik
drop-downlist dengan cara sebagai berikut :

a) Drop-downlist box harus terhubung dengan halaman kerja
daftar akun. Bukalah halaman kerja daftar akun, lalu blok
range kolom kode akun.

b) Selanjutnya beri nama range untuk kolom kode akun dengan

nama “AKUN?” seperti gambar dibawah ini.
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Gambar 2. 3
Pemberian Nama Range Akun
PRI

Fp  WOG13E.33
Fip 6726660567
Bp 11053333335

Bp _ FIIT3EAT

I Meru | daftar akun , _Data Perlengkepan & bahan beku Data Perslatandfengunen | Trar

Sumber : telah diolah oleh penulis

¢) Kembalilah ke halaman kerja jurnal umum. Blok range kolom
range kode akun
d) Selanjutnya klik menu data kemuadian pilih Data Validation

¢) Muncul menu data validation seperti berikut ini :

Gambar 2. 4

Menu Data Validation
Datavadation TP

(Settngs || tnput Message | Error et |
Valdation criteria

Allow:
IA"YV‘hﬂ vl F Ig'noreblark
Data:

between ¥

rlniyhuemmhalohmlsviﬂlmemutﬁm

geral | [ ok | coxe |

Sumber : telah diolah oleh penulis

f) Selanjutnya pada kotak allow Any value diganti dengan /ist dan

hilangkan tanda ignore blank
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g) Pada kotak saurce ketik “=AKUN” nama range yang sudah

dibuat pada lembar halaman kerja akun.

Gambar 2. 5

Pengisian Kotak Saurce dan Data Validation
20

Settings | Input Message | Error alert |
Validation criteria
Allow:

[list =] I 1gnore plank
Data: ¥ n—cell dropdown
Ibet‘n-een _'_I

Source:

[ =axuni Bl

I™ Apply these changes to all other cells with the same settings

Cear Al | [ ok | cona |

Sumber : telah diolah oleh penulis

h) Selanjutnya pada kotak Error Alert, ketik pesan error :

“MAAF KODE SALAH” dan klik OK.

Gambar 2. 6

Peniisian Error Alert
Data Validation ) _:.'_I_D'SJ

Settings | InputMessage  Error Alert |
[V show error alert after invalid data is entered
When user enters invalid data, show this error alert:

Style: Tite:
fstop =)
Error message:
MAAF KODE SALAH| -]

(%)

ear Al | o | _conca |
Sumber : telah diolah oleh penulis

1) Lihatlah hasilnya pada lembar kerja jurnal umum, akan terlihat /ist

box kode akun sebagai berikut.
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Gambar 2.7
Format List box kode akun

Kas 1-110 ~| 3,000,000
Penjualan EEELN 3,000,000
Beban Gaji 6-100 \300,000
Kas 1110 N 300,000
Perlengkapan 1-140 475,000
Kas 1-110 475,000
Pembelian Bahan Baku 5-110 10,920,000
Kas 1-110 10,520,000
Beban Penyusutan Peralatan 6-400 350,000
Kas 1-110 350,000
Perlengkapan 1-140 170,000

Sumber : telah diolah oleh penulis
j) Jika kode akun diisi dengan kode yang salah, maka diisi dengan
clain kode akun lalu enter maka akan muncul kotak pesan error
“MAAF AKUN SALAH”
k) Untuk kolom kode pembantu langkah yang digunakan sama dengan
cara jurnal umum.
1) Jika kode diisi dengan kode yang salah, maka akan muncul kotak
pesan error “MAAF KODE SALAH”
m) Pada lembar kerja jurnal umum buatlah rumus pada kolom Akun-1,
Akun 2, Bantu 1, dan Bantu 2 seperti berikut :
e Pada sel A6 ketik rumus =B6&H6
e Pada sel B6 ketik rumus =COUNTIF($SH$6:H6,H6)
e Pada sel C6 ketik rumus =D6&J6
e Pada sel D6 ketik rumus =COUNTIF($J$6:J6:J6)
n) Selanjutnya sorot rumus ke sel — sel dibawahnya

0) Isilah data jurnal umum dari transaksi yang terjadi sebagai berikut :
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Gambar 2. 8
Pengisian Data Jurnal Umum
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1/3/2025 [Penjualan Tahu sebanyak 30 ember |Kas 1-110 3,000,000
1/3/2025 Penjualan Tahu sebanyak 30 ember |Penjualan l4-100 3,000,000
1/3/2025 (Membayar gaji karyawan Beban Gaji 6-100 300,000
1132025 Memb gaji karyawan Kas 1-110 300,000
1/3/2025 [Membeli Ol bekas Perleng; 1140 475,000
1/3/2025 (Membeli Ol bekas Kas 1110 475,000
1/3/2025 [Membel kacang kedelai ian Bahan Baku 5-110 10,920,000
1/3/2025 [Membel kacang kedelai Kas 1-110 10,920,000
1/3/2025 [Membel bensin mobi Beban 6-400 350,000
1/3/2025 [Membeli bensin mobi Kas 1-110 350,000
11312025 IPembelian solar Perlengkapan 1-140 170,000
1/3/2025 [Pembekian solar Kas 1-110 170,000
11312025 [Membel Cuka Pembelian Bahan Baku 15-110 320,000
1/3/2025 [Membeli Cuka Kas 1-110 320,000
1-124
213/2025 (Penjualan Tahu sebanyak 30 ember |Kas 1-110 3,000,000
213/2025 [Penjualan Tahu sebanyak 30 ember |Penjualan 14-100 3,000,000

Sumber : telah diloah oleh penulis

4. Format Buku Besar

Buku besar adalah buku yang mencatat rincian transaksi keuangan yang

rekeningnya sama dimana datanya bersumber dari jurnal umum. Format

buku besar berisikan tentang kolom no, tanggal, bukti, keterangan,

debit, kredit, dan saldo awal.
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Gambar 2.9
Format Buku Besar

Kode Akun 1-230

Pos Saldo

Db

Nama Akun  |Kendaraan

Saldo Awal

132,000,000

132,000,000

132,000,000

132,000,000

132,000,000

132,000,000

132,000,000

132,000,000

00 [~ e fun [ Jw [ pa [

132,000,000

w

132,000,000

10

132,000,000

11

132,000,000

12

132,000,000

13

132,000,000

Sumber : telah diolah oleh penulis

Langkah — langkah dalam membuat buku besar :

1) Buat lembar kerja buku besar pada sheet ke lima

2) Ganti nama sheet 5 tersebut menjadi buku besar

3) Buatlah drop-down pada sel C6 yang berisi kode akun

Gambar 2. 10

Drop-down list yang berisi kode akun
Kode Akun  [1-230 [+

Nama Akun  [Kendaraan '\

I

Sumber : telah diolah oleh penulis

129 Ann Ann

4) Buatlah rumus VLOOKUP pada sel C7 yang digunakan untuk

mengii data nama akun secara otomatis sesuai dengan kode akun

yang terdapat pada kode akun sel C6. Sebelumnya buat terlebih
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dahulu nama range yang terdapat pada halaman kerja daftar akun
dengan cara diblok kolom A hingga G dengan mengarahkan kursor
yang terdapat pada header kolom sehingga kursor tersebut berbentuk

panah arah kebawah.

Gambar 2. 11

Pengisisan nama akun secara otomatis
DAF_AKUN1 - (= 5 | TAHUDR

3
EH |
8 |
[ |
0 |
o[
2 |
< |
u |
1 |
[
|
® [
13 |
El
21 2=
2z
23 |
|
& |
|
2t |
Xl
2 |
@ [t
3
2 |
Al
T
5 |l
i
w

{ i 5 S i = o S e B e B |

Sumbr : telah diolah oleh penljs
Kembalilah pada halaman kerja buku besar dan letakkan kursor pada
sel C7 serta ketik rumu sebagai berikut :

~VLOOKUP(C6,daftar_akun,2,FALSE)

Gambar 2. 12
Pengisian nama relasi

SUM v (© % « f| =VLOOKUP({C6,daftar_akun,2,FALSE)|
|
A | 8 | c | D ‘ E |
Kode Akun 1-230
Nama Akun  =VLOOKUP(C6,daf
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Sumber : telah diolah oleh penulis
6) Buatlah rumus pada sel G6 untuk mengisi data — data pos saldo yang
sesuai dengan kode akun tang dikerjakan pada halaman kerja kode
akun yang akan diisi pada sel C6. Rumus yang akan digunakan
hamper sama dengan rumus VLOOKUP pada langkah ke-5 dan
hanya mengubah urutan kolom data yang dibaca menjadi urutan ke-
3 dengan rumus sebagai berikut :

=VLOOKUP(C6,daftar akun,3,FALSE)

Gambar 2. 13

Pengisian Pos Saldo

SUM (% v fe| =VLOOKUP(c6,daftar_akun,3,FALSE]

H

A | 8B | c© ] D E | F

_ Kode Akun [1-230 1 Pos Saldo _ =VLOOKUP(C5,
Nama Akun  |Kendaraan Saldo Awal | 132,000,000

1 132,000,000
2 132,000,000
13 3 132,000,000
1 [ 132,000,000
137 AN NN

BEBe e uovslewne

Smumbc; : telah diolah oleh penulis

7) Buatlah rumus pada sel G7 yang bertujuan untuk mengisi nilai saldo
awal yang sesuai dengan kode akun yang ada pada sel C6 rumus
yang digunakan hamper sama dengan rumus pada langkah ke 6,
namun kolom yang dibaca ada 2 data yaitu kolom data saldo awal
debit pada urutan ke 6 dan kolom data saldo awal kredit pada urutan
ke 7 dengan rumus sebagai berikut :
=VLOOKUP(C6,daftar akun,6,FALSE)+H(VLOOKUP(C6,daftar a

kun,7,FALSE))
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Gambar 2. 14

Pengisian Saldo Awal
| SUM (" X+ )fr| =\"LOOKUP[CG,daftar_akun.G,FALSEI+IVLOOKUP[CS,daftaf_akun,?,FAlSE]ﬂ

A B c D 3 (T s
1
2
3
a
5
5  KodeAkm [1-230 1 Pos Saldo | pb
7 NamaAkun [Kendaraan Saldo Awal =VLOOKUP(CS,

8
9.
10

Sumber : diolah oleh penulis
Buatlah rumus — rumus pada kolom no, tanggal, bukti, keterangan,
debit, dan kredit dengan tujuan untuk memindahkan data — data yang
ada pada jurnal kedalam buku besar yang didasarkan kepada kriteris
akun. Sebelum membuat rumus terlebih dahulu bukalah halaman
kerja jurnal umum dan buatlah nama range pada halaman kerja
tersebut dengan memblok kolom A sampai L, kemudian ketik nama
range JU AKUN pada kotak name box nama range tersebut
memiliki kegunaan untuk membantu perumusan pada kolom
tanggal, bukti keterangan, debit, dan kredit.

a) Rumus untuk mengisi kolom tanggal
=IF(ISERROR(VLOOKUP(A11&S$CS$6,ju_akun,4,FALSE))=T
RUE,"",(VLOOKUP(A11&$CS$6,ju_akun,4,FALSE)))

b) Rumus untuk menghitung kolom bukti
=(VLOOKUP(A11&$C$6.ju_akun,5,FALSE)

Jika memperoleh hasil #N/A maka, gunakan rumus IF dan
ISSERROR
=IF(ISERROR(VLOOKUP(A11&S$CS$6,ju_akun,5, FALSE))=T

RUE,"",(VLOOKUP(A11&$C$6.ju_akun,5,FALSE)))
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Rumus untuk mengisi kolom keterangan
=IF(ISERROR(VLOOKUP(A11&S$CS$6,ju_akun,6,FALSE)
Jika memperoleh hasil #N/A maka, gunakan rumus IF dan
ISERROR
=IF(ISERROR(VLOOKUP(A11&S$CS$6.ju_akun,6,FALSE))=T
RUE,"",(VLOOKUP(A11&S$CS$6,ju_akun,6,FALSE)))

Rumus untuk mengisi kolom debit
=[F(ISERROR(VLOOKUP(A11&S$CS$6,ju_akun,9,FALSE)
Jika memperoleh #N/A maka, gunakan rumus IF dan ISERROR
=IF(ISERROR(VLOOKUP(A11&S$CS$6.ju_akun,9,FALSE))=T
RUE,"",(VLOOKUP(A11&$CS$6,ju_akun,9,FALSE)))

Rumus mengisi kolom kredit
=]F(ISERROR(VLOOKUP(A11&S$CS$6,ju_akun,10,FALSE)
Jika memperoleh #N/A maka, gunakan rumus IF dan
ISSERROR
=IF(ISERROR(VLOOKUP(A11&S$CS$6,ju_akun,10,FALSE))=
TRUE,"",(VLOOKUP(A11&$CS6.ju_akun,10,FALSE)))
Selanjutnya melengkapi rumus yang ada pada kolom saldo
dengan cara ketik :
=IF($G$6="Db".$G$7+SUM(SES$11:E1000)-
SUM($F$11:F1000),SG$7-

SUM(SES11:E1000)+SUM($F$11:F1000))
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Neraca lajur (worksheet) adalah tahapan untuk membantu penyusunan

laporan keuangan perusahaan. Neraca lajur dapat menjadi acuan dalam

pengambilan keputusan oleh perusahaan. Dengan adanya neraca lajur

bisa mengelola keuangan perusahaan dengan lebih mudah dan

terstruktur.

Langkah — langkah membuat neraca lajur seperti berikut :

a) Buatlah halaman kerja neraca lajur pada sheet tujuh.

b) Isilah kode akun pada kolom kode akun dengan cara manual sesuai

dengan kode akun yang telah ada pada halaman kerja daftar akun.

¢) Selanjutnya, buatlah rumus pada kolom nama akun untuk

menuliskan data nama akun sesuai dengan kode akun yang ada pada

sebelah kiri kolom nama.

=VLOOKUP(A11,daftar_akun,2,FALSE)

d) Selanjutnya, buatlah rumus pada kolom pos saldo dengan cara

mengklik sel C11 dengan mengetikkan rumus :

=VLOOKUP(A11,daftar akun,3,FALSE)

Gambar 2. 15

Format Neraca Lajur

1-000  |ASET

1100 |ASET LANCAR - -

1110 |kas Do 21,375,000 Lok 21,378,000

1-130 Persediaan Bahan Baku Db 6,240,000 = LPK 6,240,000

1140 |Perlengiapan [ 6,020,250 ™ 5,020,250

1-200  |ASET TETAR 5 = = -

1210 |Peralstan Db 27,915,000 - e 27,915,000 -
1220 |Akumulasi Penyusutan Peralat wr 10,290,000 [Lpx . 10,290,000
1-230  |Kendaras (o] 132,000,000 - e 132,000,000 -
1-240 Akumulasi Penyusutan Kendaraan [xr = 88,000,000 |LPK - 88,000,000
1250 |Bangunan [ 199,166,667 ™ 199,166,667

1-260 | akumulasi Penyusutan Bangunan r - 110,833,333 |LPK - 110,833,333
2-000 _ [uasiuTas - - - -
2:100 [Hutang Usaha kr - e

2-200  |Hutang Lain-lain Kr - e

3-000 EKUITAS - - - »
3100 |Modal wr 214,273,667 [LPK 114,273,867

Suy

ata PersatandEangran

Trancain

mber : telah dilolah oleh penulis

Trarcam PergSap  Jumal

G Besw | WeracaLajor B Laple

[T ]
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6. Format Laporan Harga Pokok Produksi

Laporan Harga Pokok Produksi adalah laporan keuangan yang merinci

semua biaya yang dikeluarkan perusahaan dalam proses produksi

barang atau jasa selama periode tertentu.

Langkah — langkah membuat format laporan laba rugi sebagai berikut :

a) Buatlah laporan harga pokok produksi pada sheet berikutnya.

b) Ganti nama sheet menjadi “HPP”

¢) Selanjutnya, masukkan angka yang termasuk dalam kategori laporan
harga pokok produksi dengan cara ketik = lalu ambil angkanya dari
neraca lajur sesuai dengan akun — akun yang ada pada laporan harga
pokok produksi.

d) Jumlahkan nilai pada masing — masing akun dengan menggunakan
rumus fungsi =SUM

e) Hasil perhitungan laporan harga pokok produksi sebagai berikut :

Gambar 2. 16

Format Laioran l-laria Pokok Produksi

Persediaan Bahan Baku (Awal)
Pembelian Bahan Bakn

Bahan Baku yang Tersedia Untuk Dipakai
Persediaan Bahan Baku (Akhir)
Pemakaian Bahan Baku

Beban Gaji

Biaya Overhead Pabrik

Beban Perlengkapan

Beban Penyusutan Peralatan

Beban Penvusutan Kendaraan

Beban Penyusutan Bangunan

Jumlah Biaya Overhead Pabrik

Biaya Produksi

Persediaan Barang Dalam Proses (Awal)
Persediaan Barang Dalam Proses (Alkhir)
Harga Pokok Produksi

Unit

HP produksi per ember

Sumber : telah diolah oleh penulis
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7. Format Laporan Laba Rugi

Laporan laba rugi adalah laporan yang menyajikan informasi

pengeluaran, pendapatan, serta laba atau rugi yang dihalsilkan

perusahaan selama periode tertentu. Melalui laporan laba rugi ini, bisa

memperlihatkan kinerja keuangan dari suatu usaha atau perusahaan.

Langkah — langkah membuat Laporan Laba Rugi sebagai berikut :

a) Buatlah Laporan Laba Rugi pada Sheet berikutnya

b) Ubahlah nama sheet menjadi Laporan Laba Rugi

¢) Selanjutnya, masukkan angka yang termasuk dalam kategori pada
akun —akun Laporan Laba Rugi

d) Jumlahkan nilai pada masing — masing akun dengan menggunakan
fungsi =SUM pada bagian jumlah/total.

e) Hasil perhitungan Laporan Laba Rugi sebagai berikut :
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Gambar 2. 17
Format Laporan Laba Rugi

|4-000 PENDAPATAN
| 4-100 Penjualan
Jumlah Pendapatan

|5-100 Harga Pokok Penjualan
Persediaan Barang Jadi Awal
Harga Pokok Produks
Tersedia untuk dijual
Persediaan Barang Jadi Akhir

'5-Lcc Harga Pokok Penjualan
| Laba Kotor
6-000 BEBAN OPERASIONAL
|6-100 Beban Gaji
|6-200 Beban Listrik & Air
|6-300 Beban 88M
_E-&OC Beban Penyusutan Peralatan
|6-700 Beban Lain-lain
Jumlah beban operasional
Laba Bersih

Sumber : telah diolah oleh penulis
8. Laporan Posisi Keuangan
Laporan posisi keuangan adalah sebuah laporan keuangan yang memuat
kondisi harta, kewajiban, serta modal pada kurun waktu tertentu. Tujuan
utama membuat laporan posisi keuangan ini adalah sebagai dasar
analisis arus kas pada masa mendatang. Ada kalanya laporan posisi
keuangan jga disebut dengan istilah “balance sheet”. Langak — langkah
membuat laporan posisi keuangan sebagai berikut :
a) Buatlah Laporan posisi keuangan pada sheet berikutnya.
b) Ubahlah nama sheet dengan Laporan Posisi Keuangan
¢) Selanjunya, isilah data berupa angka — angka pada laporan dengan
mengambil angka dari neraca lajur.

d) Jumlahkan asset ckuitas dan ckuitas dengan menggunakan rumus

=SUM
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1-000
1-100
1-130
1-140

1-200
1-210
1-220
1-230
1-240
1-250
1-260

2-000
2-100
2-200

b W[ Transaks .~ TranssksiPenjSaja . Jurnal , BukuBesar . Meracalajur . HPP L

Gambar 2. 18
Format Laporan Posisi Keuangan

ASET

ASET LANCAR

Parsediaan Bahan Baku
Perlengkapan

Jumlah Aset Lancar

ASET TETAP

Peralatan

Akumulasi Penyusutan Peralatan
Kendaraan

Akumulasi Penyusutan Kendaraan
Bangunan

Akumulasi Penyusutan Bangunan
Jumlah Aset Tetap

Total Aset

LIABILITAS

Hutang Usaha

Hutang Lain-lain

Sumber : telah diolah oleh penulis

9. Format Daftar Menu dan Hyperlink
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Hyperlink digunakan untuk menghubungkan satu file atau dokumen

dengan file lainnya. Hyperlink juga sering dipakai untuk menunjukkan

lokasi teks ataupun objek yang sedang diperlihatkan. Hyperlink bisa

dengan mudah ditemui saat kita mencari informasi dilaman situs/sheet.

Gambar 2. 19
Menu Hyperlink

Excel For Accounting

Nama Perusahaan | Pabrik Tahu
Bulan | Maret
Tahun [2025

Sumber : telah diolah oleh penulis
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Berikut langkah — langkah membuat daftar menu yang langsung terlink kepada

laporan keuangan perusahaan sebagai berikut :

a. Link Daftar Menu ke Halaman Kerja
I. Mengubah nama Sheet pada halaman pertama dengan Daftar Menu.
2. Klik insert, pilih shape pada menu bar
3. Pilihlah bentuk latar yang anda inginkan
4. Buatlah susunan siklus akuntansi yang diperlukan untuk dilinkkan
berdasarkan urutannya

5. Klik salah satu dari siklus akuntansi yang sudah dibuat.

Gambar 2. 20
Hyperlink

Excel For Accounting

Nama Perusahaan |Pabrik Tahu
Bulan Maret
Tahun 2025

Sumber : telah diolah oleh penulis

6. Klik kanan, pilih Hyperlink
7. Pilihlah Place in This Document
8. Pilihlah halaman atau sheet yang akan anda linkkan dengan daftar menu
9. Klik OK
b. Link halaman kerja ke pada daftar menu

I. Buka halaman kerja yang akan anda /ink kan dengan daftar menu

Dipindai dengan CamScanner


https://v3.camscanner.com/user/download

40

2. Buatlah shapes pada menu insert sesuai dengan bentuk yang diinginkan

dengan keterangan daftar menu pada halaman kerja yang akan di link

kan ke daftar menu.

3. Klik kanan shapes yang anda buat pada halaman kerja

4. Pilih Hyperlink

5. Pilihlah Place in This Document

Gambar 2. 21
Menu Insert pada Hyperlink

2

Link to: Text to display: I <Selection in Document > » ScreenTig... |
i) Type the cell reference:
Existing File or l’“
Web Page
Or select 3 plage in this document:
Menu
e - 'daftar akun'
Hg;:x ‘Data Perlengkapan & bahan baku'
‘Data PeralataniBangunan’
Transaksi
L "Transaksi Penj Saja’
Create New |
Document e
‘Buku Becar'
- ‘Meraca Lajur’
L PP
E-mail Address
[ ] _ome |
Sumber: telah diolah penulis

6. Pilihlah Sheet halaman kerja daftar menu

7. Kilk OK
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